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Abstract. Work presented in this paper focuses on the design of a computer-mediated
system for supporting group planning on the World-Wide Web platform. It is shown
that, by developing a set of appropriate intelligent tools and providing a public-domai n
applicat ion, any Web browser, such as Mosaic or Netscape, may be sufficient for an
agent to take part in a planning procedure. The specific role of the system is that of an
assistant and advisor , recommending solutions and leaving the final decisions and
actions to the age nts. In other words, it emphasizes on a human-human coordi nation,
communication and problem solving, rather than on a human-machi ne one . The
proposed framework decomposes the problem of group planning into decision-making,
uncertainty handling, constraint satisfaction and propagation, and integrates them
appropriately.

KeywordB: Group decision support systems, world-wide web, planning, argumentation,
computer-supported cooperative work.

1. INTRODUCTION

The basic objective in planning is the identification of and selection among
alternative courses of action. In real world planning instances one has to take into
account t he following:
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• SRA: "system recommended accept",
• SRR: "system recom mended reject". and
• NSR: "no system recommendation".

16 1

Issues consist of t wo parts: a set of alternative propositions and a set of rela ted
constraints. The proposit ions represent t he positions asserted so far . The issue is which
alternative position to prefer , if any. In add ition, each issue includes a dummy posit ion,
namely nil, denoting the se lection of none of t he cur rent positions. Nil provides a
means of indicating that none of the alternative propositions in an issue is
recommended . Constraints provide a qualitative way to argue about preferences and
val ue judgements in order to weigh reasons for and against a certain option. In other
words, t hey give the users the ability to rank the quality of alternative positions.
Constraints are interpreted as meto -ieeuee, including a nil position as well as possible
constraints on them. This provides a means of expressing the agent's belief for the
constraint, that is, either acceptance or rejection of it, or no decision about its validity.
Finally, arguments are assertions about the positions regarding their properties or
attributes, which speak for or against the m. We allow two kinds of arguments:
supporting arguments (pro) and counterarguments (con). An argu ment links together
two propositions of different issues.

In order to make the above concepts more clear, we give the following example:
the goal of a part of a planning problem is to find a constructor for a specific tool. There
are some alternative choices already asserted, that is to order it from two candidate
subcont ractor companies, Const ructor- l and Constructor-2 . Decision makers argue
about the quality, delivery time and costs that the above alternatives provide. In this
instance, t he issue is • linda constructor for the toor and the existing propositions are
"select Constructor-V and "select Conetructor-T, A supporti ng argument for the first
proposition may be: "Constructor-! offers high quality work- ; a counterargument for the
second proposition may be: "Constructor-2 is expensive- ; constraints asserted may be:
"quality is considered to be more important than price- , andlor -theco·existenee of low
quality and low price is considered more important than delayed deli very- .

Following [21, we consider that there are no unrefutabl e arguments. In
addition , t wo conflict ing arguments can be simultaneously applied. An instance of the
sys te ms st ructure is presented in Fig. 1. Positions are denoted with ellipses (the nil
positions are shaded), issues with rectangles, supporting arguments with plain arrows,
and counterarguments with arrows crossed by a simple line. Const rai nts appear in t he
second part of each issue. Due to space limitations, they are simply shown with shaded
rectangles, although they retain the full structure of an issue.
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Figure 1: An instance of the system's st ructu re.

Our framework draws on concepts first introduced in 131 about a Qualitative
Value Logic (QVL), a logic for defeasible Qualitative decision making. As illustrated in
(tol , s upport ing and cou ntcrargu ments ca n be weighed against each other. The
const ra ints of an issue allow for a combination of weak arguments to defeat a strong
a rgu ment .

The subject of priority relationships and preference orders has been mostly
handled th rou gh quantitative approaches (sec for example [151 and 1191l, using the
concepts of thl ' cost o( not taking a premise into account and confidence (actors .
respect ively. \ ....ell-defined utility and probability functions regarding properties or
uuributes of ultcrnut ive positions. used for example in traditional OR approaches, as
well ail complete ordering of these properties are usually absent. On the contrary. a
complete preference ordering among arguments is not a lways attainable; there may be
Hom e formal properties such us transit ivity and non-circularity, but st ill a partial
ordering is often nil that we are able to achieve. In addition. t he re is not always
complete information for each alte rnati ve proposit ion of an issue regardi ng t he
ut t r ibu tca assorted by the urguments . For instance, in order to conclude an issue with
two nltcrnutive propositions A nnd B. it is possible that we only know that "A has the
attributes a. b and c", while "R has the attributes a and d" (consider a lso the case where
no informutinn regarding the ordering of a. b. c, d has been given ).

T rying to so lve an issue, our framework cons iders the related supporting and
counte r arguments as well as the asse rted constraints . Depe nding on the information
provided . the system ca n:
• recommend the acceptance of a single proposit ion (SRA), and, consequently , the

rejection of the rest of them (SRR);
• recommend the reject ion of so me positions (for example. in cases re-sulting in only

partia l prefere nces among the positions, the SRR label may appear m ~ n·2 times,
where n is the nu mber of the alte rnat ives ), or

• make no recommendation at a ll.
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Let I be the set of issues in a debate,I = (11. 12, ••• , I II I. Cj t he set of const raints
of an issue i , Cj = ICi,l' Ci .2• ...• c i,. l . Pi the set of propositions of an issue i, Pi = (Pi,l.
P j ,2' ...• Pj.p l u nil, , n, k, p EN, and ~' = {P" I> Pj ,2• ..., Pi,pl = Pi • nil.: Let also the
functions label (xl, x e Pi, and con (Y) , y E I , stand for the labelling of propositions and
the conclusion of issues, respectively. As stated above. arguments link together
propositions of different issues , In the proposed system. we do not allow cycles,
Consequently, the st ruct ure of the system is tree-like. The decision -making procedure
follows a bottom-up approach. starting from the leave issues and heading for more
"coarse" ones. A first outline of the decision making procedure taking place in each
issue is given below (lines starting with # represent comments) :

. . .
man issue t:

conclude the constraints Cu , Cj ,2' .. " Cj ••

# find the accepted, rejected and undecided ones
if the accepted constraints are inconsistent

then con (i) = undecided
else {

label (x)=NSR. 'r;I x e P/
# initially we assume that every position is fWt recommended
solve the issue # find total or partial preferences

labelling and conclusion of the issue
propagation of decision
I

endif

The labelling procedure for the propositions of an issue i is:

if (opt imal solut ion := Pj ,% )

then {
label (Pi,%)=SRA;
label (Pi,,) =SRR, 'r;I Pj" e P;' •yn;
label (nil i)= SRR;
I

eleeif (Pi,' better than P;,m)
then {

label <Pi .m )~SRR;

label (nilj)=SRA;
I

else {
label (Pi,II) = SRR, 'r;I Pi, lI e P;';
label (n il;)~SRA;

I

Finally, the conclusion procedure is:

if (3 PiJ e P;' 3 label (Pijl=SRA)

then con (i) = decided
else con (i) = undecided
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Init ially, any issue of the problem is considered undecided . After the labelling
and conclusion procedures. propeestion of the event ual decision has to take place.
Obvious ly, this has to he done on ly when a solut ion has been found (for more, see (l0 » .

3. CSCW AND THE WORLD WIDE WEB PLATFORM

The argu mentation framework presented above may exploit advancements in
electronic communication and comput ing. Computer Supported Cooperative Work
(CSCW) has been defi ned as computer-assisted coordinated activity for communication
and problem solving, carried out by a group of collaborating individuals 17(. (8]. Key
issues of escw are group awareness, multi-user interfaces, concu rrency cont rol,
communication and coordi nation within the group, shared information space, and the
support of a heterogeneous, open environme nt, which integrates exist ing single-user
applications.

The most success ful CSCW technology to date is undoubtedly the electron ic
mail . Other well-developed technologies so far include comp uter conferencing (based on
a struct ured form of electronic mail , in which messages are organized by topic and
dialogues lire often mediated by a convenor), teleconferencing or desktop
videoconferencing <t he act of conferencing at a distance with the aid of audio and video
links ), group au thoring (enabling cooperat ive writing with additions, revisions,
comments an d an notat ions ), and group decision support systems (where problem
solving is d irected at iss ue organization and decision support). The last category
consists of med iat ing sys te ms that support discussion, argu mentation. negotiat ion and
decision making in groups.

Most taxonomies of CSCW technologies disti nguish them in terms of their
abilities to bridge time and space. However, this is a rough distinction, initiated from
their init ial or most common usc. Cit ing 11I, CSCW technologies of the future should
focus on an any n me . any place environment. CSCW is currently st rongly supported
and explored from both industry and academic research [241.

A principal aim for the designer of a planning system for groups should be to
apply state-of- t he-art CSCW technology to provide advanced support for the users over
wide area networks, in particular the Internet. The leading commercial groupware
products, such as l.atue Notes and DEC's U nkWorks, are generic tools for developing
grou pware applicat ions within a s ingle organizat ion. primarily over local area
networks. Usually, a planning environme nt requires support for commu nicat ion and
cooperat ion across organizat iona l, or even nat ional, boundaries . The primary
advantages of commercial systems over the Web and other Internet se rvices, a t the
moment . arc well -Integrated tools for creat ing documents and messages . Unfortunately.
these systems typically usc proprietary formats and communications protocols .
Conversely, the phmary weakness of the Web as a basis for groupware (t hat is, the
multi -user softwa re supporting CSCW 1511 is the present difficulty for ordinary users to
crea te, link , index and store new documents. Two developments make it easier for them
to develop content , which can he dlsserninntcd over the Web: (i) the increasing
availability of HTML and SGML editors, often as extensions to popular word processors
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and (ii) t he use of Portable Document Format , which may be generated automat ically
from almost any document using a special printer driver.

In addition, most persons will not want or be able to maintain a Web server. A
way must be found to provide users with the opportunity to add information and assert
their positions, which does not exacerbate the already difficult problem of later finding
and retrieving information. Computer conferencing and group decision support systems
al leviate this problem by using the discourse structure of a set of related messages to
automatically index and organize the data base of documents. For example, messages
may be organized by topic or "thread" in a hie rarchy according to the "reply" relat ion.
The Web does not yet support this kind of interaction well. What is needed is a better
integration of conferencing systems. such as the Usenet news groups, group decision
support technology. such as Issue-based Informat ion Systems, and the Web. There have
been some experiments along these lines, such as Web Interact ive Talk and the Open
Meeting project in the USA. Following the above, CSCW technology is better applied. to
construct mediation systems. for supporting a "round table" discussion between equal
partners, rat her than control systems for managing the interests of a single actor. A
mediation system assists the "trusted third parties", i.e., persons having no personal
stake in the outcome of the project. whose job is to facilitate negotiations, moderate
discussions. and perhaps arbitrate the resolut ion of disputes.
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Figure 2: The World Wide Web gateway.
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Fig. 2 illustrates a mock-up of a Web gateway through which each planning agent
might assert his own posi tions and constrai nts in a planning paradigm (see also 111)).
The File menu includes the usual commands such as New, Open, Close, Send, Save,
P rint or Qui t a plan . Each paradigm contai ns all corresponding posi tions, arguments
and const raints asserted so far via our mediating system. The specificat ion of rights and
duties among agents would affect their potential access to the list of avai lable
commands. Several agents can open and modify the same plan simultaneously. An
Agent can modify the discussion by asserting new positions, an d consider alternative
decisions in spite of the system's recommendations. "What-if " scenarios might be tested
before an agent decides about what he final ly wishes to assert . The Edit menu includes
the usual Undo, Cut, Copy, Paste, Clear, Select, Find and Replace commands. Similarly,
the View, Navigate. Options and Help menus include well-tried commands from Web
browsers adapted in our formalism.

As shown in Fig. 2, the file corresponding to the problem has been retrieved
and its related issues are listed in the first scrcllable pane under the main menu bar.
The agent can select any of the m and click eit he r on the "Propositions in the Issue", or
on the "Const raints in the Issue" button to see what has bee n asserted (second
scrollable pane). Automatically, he would find out the system's conclusion for the issue
by observing for which proposit ion the "Recommend Accept" button is on. Poss ible
weaknesses for solving the issue will be represented by the "No Recomm endation"
button being on. "Recommend Reject" for a proposition indicates that the system has
ide nti fied a better alte rnative in this issue. Preserving the mediating role we intend for
the system, an agent would be able to select an alternative, and assert his own opinion
by clicking on the Users "Accept", "Reject" or "Undecided" buttons. Working this way,
age nts would be ab le to observe tbe consequen ces of their decisions at higher levels of
the planning tree an d evalua te alternative plans.

The bottom part se rves for the commitment of new propositions, arguments
and constraints in a plan. The scrollable pane would include their description. The
linking a newly asserted proposition with an existing one can be made by clicking on
one of the "Pro" and "Con" buttons (declaring intention for a supporting or a counter
argument, respectively), after the selection of the cor responding proposition. The
Navigate menu provides the usual commands for tracing the corresponding graph of
the discussion . For instance, the "Top" command leads to the prime goal of the plan,
and the "Up" and "Down" commands trace the issues at various abstraction levels.
"Next" and "Previous" commands cycle through the other arguments of a selected
proposit ion . Finally, the View menu provides suitable decision-making graphs and
options for overal l representations of a plan . For instance, other views of the dialectical
graph , such as a temporal list of past messages, will be also useful.

4. DISCUSSION

The framework presented in the previous sect ions embraces hypertext and
groupware technologies, smoothly applied on the amalgamation of a discussion model
an d classical planning algorithme. Hypertext systems feature machine-supported links.
both within and between documen ts, that have opened exciting new possibilities for
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using the computer as a communication tool. The discussion model can enhance the
quality of the dialogue process within a conceptual organization by providing the
structure for the discussion of complex problems. The motivations behind the
integration of an argumentat ion framework fo r planning are:

• to support and reason about commonly prevailing conditions in dynamic planning
environments, such as argumentation, negotiation , and conflict resolution;

• to facilitate and rationalize the communication among multiple agents in the
planning process;

• to extend and cumulate the existing knowledge across the planning agents, and
• to adapt supporting planning algorithms on qualitative decision making

environments.

Ou r fra mework stimu lates a decomposition of planning and scheduling
activities into constraint propagation, decision-maki ng, and intelligent control of both
(see also (13]). Future work should focus on an open planning support system, which
would make information more accessible and affordable, and help to open and
democratize decision making procedures. This would also improve the quality and
acceptability of decisions and reduce the cons iderable expense of unnecessary delays
and conflicts. Services that should be integrated towards such a system are (Fig. 3);

Negotiations, handling of
conflicts. debate conducting,
etc.

lntormatton transformation.
meta-data, etc.

Information search and
retrieval. etc.

Figure 3: Required services.

• The information services, which will improve the interoperability of proprietary
systems, providing efficient and cost-effective access to the mult imedia data in
heterogeneous, distributed databases, over wide-area networks. Thi s would include
se rvices for finding relevant data, converting proprietary data to standard form ats
for data interchange, as well as ways of controlling remote se rvers from within
compound documents and gene ral purpose electronic mail, conferencing systems,
and hypermedia systems, such as the Web.
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• The documentation services, which will provide a shared workspace for stori ng and
retrieving the documents and messages of the participants, using standard
document formats, such as SGML, OpenDoc, etc . Users will he able to add o.k. and
retrieve information from the hyperspace of documents available on the network .
Sec ur ity and privacy Issues should also be address..ed here . Project document
data bases may become part of the collective memory of a commu nity, facilitating the
reuse of plans, designs and their rationales .

• The medtauon services, wh ich will provide assistance for regulated group ac t ivity .
Commercial workflow systems will be used to support well-defined, formal
administrat ive procedures withi n organizations. For group planning and decision­
making procedures. services will be provided to support the human mediators of
elec tronic "round table" discussions.

The implementation of a fair, efficien t and rat ional rhetor ical model plays a
key role in such a system. Among the most prominent related work , we mention here
tbe early work of Toulmin on argumentation theory (211, Pollock 's OSCAR model of
defeasible reasoning 11 6), Rescher's work on formal disputation theory (18), and the
Is....ue-Besed Informat ion System (IBIS) rhetorical method developed at MeC 14). The
legit imate aspect of logic behind such a rhetori cal model , in order to implement a set of
norms for regula ti ng this kind of discourse, has been highlighted in Toulmin 's work,
and is extensively discussed in 16) and 117). \ \'e also mention here related work comi ng
from the AI area. such as the BURIDAN planning algori thm (121, the PYRR HUS
plann ing system 123), utility models for planners 191. and the Qualitative Decis ion

Theory 120).

T he conclusion of an issue usually implies the solut ion of a const rai nt
satisfaction problem . Exploiting the abilities of a constrai nt sa tisfact ion programming
language, the system ca n guarantee consistency checking for the asserted const rai nts .
Initia l experiments have bee n made with the ECLi PSe langu age. Jointly regarding the
cons traints holding and the arguments asserted to alte rnat ive positions, concepts
conce rni ng the oplim islic or pessimistic, and the credulous or skeptical conclusion of an
issue have been Introduced in 1101. The optimistic (pessimist ic) conclusion of an issue
involves t he maximu m <mi nimum ) possible values of the al ternati ve cho ices , while t he
credulo us (akept icul) conclusion is entailed regarding the full (common) set of as sert ed
att r ibutes of t he alternat ive choices. Future work aims at a more efficient solut ion to
this problem . by exploring: al ternative const raint sat isfact ion is entailed regarding
techniques and st rengt hening the Qualitative Value Logic.

Concluding, this paper focused on the specifica tion of R fra mework that will
host the appropriate tools for support ing and reasoning about fair, rational and
effective gro up planning. A Web gateway for such syste ms has been sugges ted , a iming
a t providi ng the broadest aCCl'SS among agents, and assuri ng portability and platform­
independence. Key issues taken into account are the awareness of the plann ing agents ,
mu lti-user interfaces . commu nica tion and coordi nat ion within the group of planning
agents, shared information space and the support of a heterogeneous and "open
environ ment". T he approach proposed emphasi zes the human-human coordinat ion ,
communication and problem solving, rather than t he human-mach ine one.
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